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1. About GISsurfer

GISsurfer (https://gissurfer.com) is a general purpose web map with broad support for displaying
data hosted on various kinds of geographic information system (GIS) servers.  For a list of 
video and PDF tutorials see https://mappingsupport.com/p2/gissurfer-help.html.

2. Introduction to georeferenced images

A georeferenced image is one where you know the latitude longitude for the four edges of the
image.  Or to put it another way, you know the latitude longitude for two opposing corners. 
GISsurfer can help you produce:
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Using dynamic layers (if available) can greatly improve the appearance of
georeferenced JPG and PNG images that you make with GISsurfer.

* Georeferenced JPG or PNG images that are 100% map.  The GISsurfer interface
is not shown.

* Georeferenced images that are a single screenshot or multiple screenshots that
exactly adjoin and are stitched together.

* Georeferenced JPG files that display a basemap and data from multiple GIS
layers.

* Georeferenced PNG files that have a transparent background and data from
multiple GIS layers.

* KMZ files that contain one or more georeferenced JPG or PNG images.

Georeferenced JPGs can be displayed by GISsurfer (online) and by the GeoJPG web app (online
and offline).  In addition, KMZ files that contain georeferenced images can be displayed by
Google Earth, QGIS and various other programs.  KMZ files containing georeferenced images
can also be used to import custom maps into some Garmin GPS units.

Note that georeferenced images are best suited to static data and not appropriate for data that
keeps changing.

3. Comparison of maps with and without ArcGIS dynamic layers

By default, GISsurfer will display data hosted on ArcGIS servers using the default styling (line
color, line width, polygon fill, etc) defined on the server.  However, often times the default
styling makes the data hard to see on one or more basemaps.  If the ArcGIS server supports
“dynamic layers” for that data then you can use GISsurfer to tell the ArcGIS server to change
how the data is styled before it appears on your map.

Below is an example of the impact that dynamic layers can have.  This comparison uses two
GISsurfer map links which open at the same spot in Ventura County California.  Both maps
display the same GIS layers showing road and trail data from ArcGIS servers operated by
Ventura County and the U.S. Forest Service.  The only difference is that the first map uses
dynamic layers to change how the data is styled and the second map uses the default styling
defined on the ArcGIS servers.
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GISsurfer map with dynamic layers used to style the data
https://mappingsupport.com/p2/gissurfer.php?center=34.478195,-119.245262&zoom=13&basem
ap=USA_basemap&overlay=Ventura_County_boundary,Proclaimed_forest,USFS_road_open_bl
ack,USFS_road_open_white,Ventura_road_black,USFS_road_closed,Ventura_trail_green,Ventu
ra_trail_black,USFS_trail_green,USFS_trail_black,USFS_recreation_site&data=https://mapping
support.com/p2/kmz_demo/ventura_county_trails_1.txt

GISsurfer map with the default data styling defined on the ArcGIS servers
https://mappingsupport.com/p2/gissurfer.php?center=34.478195,-119.245262&zoom=13&basem
ap=USA_basemap&overlay=Ventura_County_boundary,Proclaimed_forest,USFS_road_open,Ve
ntura_road,USFS_road_closed,Ventura_trail,USFS_trail,USFS_recreation_site&data=https://ma
ppingsupport.com/p2/kmz_demo/ventura_county_trails_default_styles.txt

Change the basemap on both maps to “USA scanned topo” and then to one of the aerials.  Also
try “All white basemap”.  Note how hard it is to see the default data styling on some of the
basemaps.  No doubt someone had a good reason for styling the data in that manner but those
choices might not meet your needs.

Here is another comparison.  In this same general area of Ventura County I took four screenshots
that exactly adjoin and stitched them together.  I did this once using the map that displays
dynamic layers and again using the map that displays the default styling.  Here are links to the
two composite PNG files I made:

Composite PNG file with dynamic layers used to style the data
https://mappingsupport.com/p2/georeference_demo/ventura_demo_transparent_restyle.png

Composite PNG file with default data styling defined on the ArcGIS servers
https://mappingsupport.com/p2/georeference_demo/ventura_demo_transparent_default.png

As part of the process of taking these screenshots GISsurfer provided the georeference data for
each individual screenshot and also for the composite image.  Below are links to two KMZ files. 
Each KMZ file includes (1) a KML file with the georeference data and (2) one of the composite
PNG files.  These PNG files have a transparent background.  You can open these KMZ files
and display the georeferenced composite PNG file with Google Earth, QGIS and various other
software.

KMZ file with dynamic layers used to style the data
https://mappingsupport.com/p2/georeference_demo/ventura_demo_transparent_restyle.kmz

KMZ file with default data styling defined on the ArcGIS servers
https://mappingsupport.com/p2/georeference_demo/ventura_demo_transparent_default.kmz

To learn how to use GISsurfer with ArcGIS dynamic layers please see this PDF:
https://mappingsupport.com/p2/help/GISsurfer-advanced-arcgis-tips.pdf

3

http://bit.ly/3Aryjs5
http://bit.ly/3Aryjs5
http://bit.ly/3Aryjs5
http://bit.ly/3Aryjs5
http://bit.ly/3Aryjs5
http://bit.ly/3GrMwcf
http://bit.ly/3GrMwcf
http://bit.ly/3GrMwcf
http://bit.ly/3GrMwcf
https://mappingsupport.com/p2/georeference_demo/ventura_demo_transparent_restyle.png
https://mappingsupport.com/p2/georeference_demo/ventura_demo_transparent_default.png
https://mappingsupport.com/p2/georeference_demo/ventura_demo_transparent_restyle.kmz
https://mappingsupport.com/p2/georeference_demo/ventura_demo_transparent_default.kmz
https://mappingsupport.com/p2/help/GISsurfer-advanced-arcgis-tips.pdf


If you are using a cell phone, tablet and other touchscreen device, note that the
GISsurfer interface will let you shift the screen exactly one screen worth
up/down/left/right on any type of touch screen device.  However, making a useful
georeferenced screenshot will only work if the screenshot can be saved as a JPG
or PNG file.

4. JPG screenshot size vs your screen size (NEW)

The native resolution of the screen for my desktop PC is 1280 x 1024.  When I take a screenshot
and save it as a JPG, the size of the JPG is 1280 x 1024.  Some systems, including retina
displays, use ‘pixel doubling’ display technology.  Screenshots taken with those systems result
in JPGs that are much larger then the native screen size.  You will have the best results if you
can configure your system so that the size of the JPGs you take is the same as the native
resolution of your screen.

5. Make your first georeferenced image

These step-by-step instructions will show you how to use GISsurfer to make a single
georeferenced JPG centered on your neighborhood.  This first JPG is quite simple since it
will use only one screenshot and will show a basemap without any GIS layers added.  Doing a
simple map first will help you learn the basics.  You can use any device from a cell phone to a
desktop computer.  But with that said, you should try to use the largest screen that is available so
each screenshot covers a larger area.

Start by opening this GISsurfer map.
https://mappingsupport.com/p2/gissurfer.php

The default basemap you will see is “USA basemap”.  Click the basemap button (next to the
“Menu” button to change the basemap.  If you change to an aerial basemap for a location in the
USA, then you might want to also turn on the overlay “USA roads”.  If you are outside of the
USA then take a look at the basemap “Open Topo Map” which is based on data from the Open
Street Map (OSM) project.

Zoom in on your neighborhood or click/tap Menu ==> Search.  You can search on addresses,
town names, coordinates, etc.

Decide what zoom level you will use when you take the screenshot.  If necessary, drag the map to
where you want it centered.

PC and Keyboard users (scroll down if you are using a touchscreen or a MAC or if
these keyboard instructions do not work with your system)
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A. Open the program you are going to use to save the screenshots.  On a windows computer
the Paint program works fine.  This is the old 2D version of Paint.

B. Go back to the map and press F11 to remove the browser controls from the screen.  Now
press F11 again.  Doing this sometimes causes the coordinates for the center of the map to
change slightly.  This step is important so, if necessary, you can replicate the same
starting point for a series of screenshots.

C. Press F11 to remove the browser controls from the screen.

D. Click Menu ==> Screenshot mode.  The GISsurfer controls are removed from the
screen.

E. Click ‘Read me” for some useful information.  Answer the question about touchscreen by
clicking “No” and then click “Ready to take screenshots”.

F. Take a screenshot.  On a windows PC, hold down the alt key and pressing the “Print
screen” key.  

G. Hold down the alt key then hit the tab key.  Keep holding down the alt key and use the
arrow keys (or tab key) to highlight the program you will use to save your screenshot. 
Release the alt key, paste in your screenshot and save it as a jpg file.  

H. Hold down the alt key then hit the tab key.  The screen will shift back to GISsurfer. 
Release the alt key.

I. Exit screenshot mode by pressing F11 to restore the browser controls and pressing ESC to
restore the GISsurfer controls.

J. Save the georeference data.
When you press ESC the screen shows several buttons.  Each one will copy the

georeference data into the clipboard.  If you followed this script then you only took one
screenshot so press either ‘Georeference’ button and then paste that data somewhere and
save it.  Then press either KML button and  paste that data somewhere and save it. 

The coordinate data is in the order bottom latitude, left longitude, top latitude, right
longitude (south,west,north,east).  The clipboard data will also include a GISsurfer link
that will replicate the map you used to take the first screenshot.  If you are doing a
series of screenshots and make a mistake on one of them then you can use that link to
open the map, go into screenshot mode, shift the screen up/down/left/right and redo just
the bad screenshot.

Touchscreen and Mac users
Mac users must answer “yes” to turn on the touchscreen interface.  All this does is create 5
invisible hotspots on the screen that can be clicked using any pointing method.  One hotspot is an
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If you put your georeferenced image files online then you will have more flexibility
in how those images can be displayed.

area at the center of the screen.  The other four hotspots are areas at the middle of each edge of
your screen.  If you are taking multiple screenshots then tap one of those four hotspots when you
want to move the screen exactly one screen worth in that direction.

A. Tap Menu ==> Screenshot mode.  The GISsurfer controls are removed from the screen.

B. Tap ‘Read me” for some useful information.  Answer the question about touchscreen by
tapping “Yes” and then tap “Ready to take screenshots”.

C. Take a screenshot only of what the browser is displaying, not the entire screen.
Many phones save screenshots as PNG files.  Your device may or may not have a
setting that lets you change that file format to JPG.

D. Critical!  Tap the center of the screen.
GISsurfer has no way to automatically detect when you take a screenshot using a
touchscreen device.  When you take a series of screenshots that exactly adjoin you
must tap the center of the screen after each screenshot.

E. Tap the button to save the georeference data and then tap the button to exit screenshot
mode.

You will see everal buttons that let you save the georeference data.  These are the
same choices that desktop users see.  See the last step in the preceeding
instructions for keyboard users.

6. Put your screenshot JPG files online for free

One of the main reasons for developing the GISsurfer screenshot feature is so that anyone can
make their own high quality custom maps and view them offline on iOS and Android devices
using the GeoJPG ‘web app’.  All of this can be done with NO ads, NO tracking, NO signup
and NO fees.  For more information see https://geojpg.com.

Georeferenced JPG maps must be online before they can be used with the GeoJPG web app. 
Good news.  Below are step-by-step instructions for how you can put your JPG files online for
free.

a. Free hosting for files on Google Drive (NEW)

Google Drive offers free hosting for a variety of file types including JPG, TXT and GPX. 
Google gives everyone 15GB of free storage which is shared across various google services
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including gmail, photos and drive.   Note that I am not talking about "Google cloud" which is a
different critter.

Google has an important rule you need to know about.  If you try to access too many files too
quickly then google will give you a 10 minute ‘timeout’ during which Google Drive does not
respond.  After that 10 minute prior everything will work fine again.  There is a page on the
GeoJPG website (https://geojpg.com) with more information on this Google Drive ‘timeout’ and
how to avoid it.

1. Sign in to Google drive
https://drive.google.com/drive/my-drive

2. I recommend you make a folder to hold your files.

3. Upload a JPG file.  You can also upload various other file types including txt and gpx.

4. Right click the filename and select “Get link”
Change “Restricted” to “Anyone with the link”
Copy and save the link.  Here is an example of a ‘share’ link for a JPG file.
https://drive.google.com/file/d/11qbADU-KTfmhUJ37UViP4oTlTfCYtJ1q/view?usp=sharing

5. Use the following website to change the ‘share’ link into the direct link.
https://sites.google.com/site/gdocs2direct/
Here is an example of the ‘direct’ link you will get.
https://drive.google.com/uc?export=download&id=11qbADU-KTfmhUJ37UViP4oTlTfCYtJ1q

The ‘direct link’ is the one that can be used to display this georeferenced JPG with GISsurfer
and to install this JPG map for offline use with the GeoJPG web app.

b. Free hosting for JPGs on Flickr (NEW)

Here are step-by-step instructions for uploading JPGs to Flickr and obtaining a direct link to the
original image.  This works both with JPGs that are a single screenshot and JPGs that are made
by stitching multiple screenshots together.  If you use Flickr a bunch please consider buying an
account.

These instructions were developed using a PC.

1.  Open https://www.flickr.com/

2.  Register if you have yet done so.

3.  Click the hamburger menu (3 bars) and select ‘Photostream’.

4.  Click the cloud symbol
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5.  Navigate to the JPG you want to upload and double click it.  A small version of the JPG will
be  displayed on the Flickr screen.

6.  In the sidebar, click “Owner settings”.  More settings will appear.

7.  If you intend that others can use this JPG then make sure there is a green box front of “visible
to  everyone”.

8.  Click “Content type” and select screenshot.

9.  In the upper right corner of the screen click the button “Upload 1 photo”.

10.  Click “Upload”.

11.  Click “Continue to photostream”.  The JPG you just uploaded is displayed first in your
photostream.

12.  Double click the JPG you just uploaded.  Just that JPG will be displayed in the center of the
screen.

13.  Near the lower right corner of the screen click the down arrow next to the shopping cart.  A
small popup appears.

14.  Rightclick “Original” and select “Copy link”.

15.  Save the link.  That link will display the original size JPG that you uploaded.  If you paste
the link into a browser tab then the JPG will be displayed.  Here is an example link.
https://live.staticflickr.com/65535/53576521041_4911d030e3_o_d.jpg

7. Display your georeferenced image with GISsurfer

Displaying a georeferenced image with GISsurfer is a quick and easy way to make sure the
georeferencing data is correct.  All you need to do is place the JPG or PNG file online and then
make a GISsurfer link like so.

https://mappingsupport.com/p2/gissurfer.php?data=____^____^____

Replace the first underline with a name you make up.  GISsurfer map link should not include any
spaces so in the name use an underscore character instead of a space.  If your JPG or PNG file is
hosted on Google Drive then the name must end with the characters ‘jpg’ or ‘png’.

Replace the second underline with the https link to the JPG or PNG file.  Links that start with
http will not work!

Replace the third underline with the georeference data provided by GISsurfer’s screenshot mode. 
This data is provided in the order bottom,left,top,right.
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The GeoJPG web app accepts the same 3-part syntax (name^link^georef).  You can use that
syntax to install a georeferenced JPG map and view it offline.

Here is a finished example that opens GISsurfer and displays a georeferenced JPG.  This JPG is
hosted on Google Drive.  Note that the Google Drive ‘direct link’ is used.
https://mappingsupport.com/p2/gissurfer.php?data=Mason_Lake_usgs_jpg^https://drive.google.c
om/uc?export=download&id=11qbADU-KTfmhUJ37UViP4oTlTfCYtJ1q^47.394631,-121.6053
49,47.442195,-121.517458

......flickr example........

If you want to display more that one georeferenced image then make your GISsurfer link as
follows.  Think of the two vertical lines || as an end-of-line indicator for information being fed to
the data parameter.  

https://mappingsupport.com/p2/gissurfer.php?data=name^https://_____^georeference_da
ta||name^https://_____^georeference_data

8. Make a KMZ file

If you want to display your georeferenced image with Google Earth, QGIS, etc, then you will
need to make a KMZ file that contains one or more georeferenced JPG or PNG files and one
KML file that has the georeference data for the image(s).

Here is an example of a completed KML file with georeference data for one image.
https://mappingsupport.com/p2/kmz_demo/_sample.kml

Here is an example of a KML file that can hold the georeference data for more than one image. 
The file has underlines where you need to add information.
https://mappingsupport.com/p2/kmz_demo/_sample_multiple_images.kml

Here is an example of a completed KML file with georeference data for six images.
https://mappingsupport.com/p2/kmz_demo/ventura_county_all_transparent.kml

The following steps for making a KMZ file are written for a windows 10 PC.

A. Use a text editor to open the KML file that you saved from the clipboard as you were
done taking screenshots with GIS surfer.  Alternatively you can open one of the example
kml files shown above.

B. The top of the clipboard data shows a GISsurfer map link which will replicate the map
that was on your screen when you took the first screenshot.  If you want to save that map

9

https://mappingsupport.com/p2/gissurfer.php?data=Mason_Lake_usgs_jpg^https://drive.google.com/uc?export=download&id=11qbADU-KTfmhUJ37UViP4oTlTfCYtJ1q^47.394631,-121.605349,47.442195,-121.517458
https://mappingsupport.com/p2/gissurfer.php?data=Mason_Lake_usgs_jpg^https://drive.google.com/uc?export=download&id=11qbADU-KTfmhUJ37UViP4oTlTfCYtJ1q^47.394631,-121.605349,47.442195,-121.517458
https://mappingsupport.com/p2/gissurfer.php?data=Mason_Lake_usgs_jpg^https://drive.google.com/uc?export=download&id=11qbADU-KTfmhUJ37UViP4oTlTfCYtJ1q^47.394631,-121.605349,47.442195,-121.517458
https://mappingsupport.com/p2/kmz_demo/_sample.kml
https://mappingsupport.com/p2/kmz_demo/_sample_multiple_images.kml
https://mappingsupport.com/p2/kmz_demo/ventura_county_all_transparent.kml


link somewhere else then do so now.  Then delete lines from the top of the file so that the
first line that remains is <?xml version="1.0" encoding="UTF-8"?>.

C. Edit the KML and then save it with the .kml file extension.
   name Add a descriptive name
   href This must be the file name and extension  for the  georeferenced image
   LatLonBox The georeference data you saved from GISsurfer is in the same order as

you see in the sample KML file - south,west,north,east.

D. Open the windows file explorer and select both the KML file and the georeferenced
image file.  (Hold down the ctrl key while clicking both file names).  If the KMZ file is
going to include multiple images then you need to select all those images along with the
KML file that has the georeference data for all the images.

E. Rightclick the highlighted file names and select “Send to > Compressed (zipped) folder”. 
A new folder will be made with the zip extension.

F. Change the extension of the folder from zip to kmz.  You might also want to change the
file name.  You now have a KMZ file that contains both the georeferenced image file(s)
and the KML file.

9. Display your KMZ file with Google Earth

The next steps will open your KMZ file in Google Earth.  This is an easy and quick way to make
sure your KMZ file has been correctly made.

A. Open https://earth.google.com/web/

B. Rest your cursor over the symbols in the left sidebar until you find the one that displays
“Projects”.  Click that symbol.

C. Select “Open > Import KML file from computer”

D. Navigate to your KMZ file and double click it.  The JPG image will appear on Google
Earth and be correctly positioned (i.e. georeferenced).  If you see a red X then check the
KML file.  If you edit the KML file then you need to re-make the KMZ file.

10. Display your KMZ file with ATAK - iTAK - WinTAK

ATAK is a free Android app developed by the federal government for situational awareness.  The
iTAK (Apple devices) and WinTAK (Windows) have fewer features.

These instructions were developed using ATAK.  You can also import KMZ files into iTAK and
WinTAK although there might be differences in the interface for doing so.
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A. Either cable your Android device to your PC and load the KMZ file into local storage or
place the KMZ file online.

B. Open the ATAK “Import” feature and select the KML option.  

C. Enter a name.

D. Tap the folder icon to import from local storage or enter a URL.

E. Decide whether the two options (Auto refresh and Remove) should be on/off and then tap
Add.  If the data that displays does not change then there is no reason to use a refresh rate
and that setting should be ‘off’.

F. The Overlays screen should appear.  Note the red X.  Tap the download icon and a green
checkmark will appear.

G. Tap the name of the overlay and the map will shift to that spot and show the
georeferenced JPG.

11. Display your KMZ file with a Garmin device

Many Garmin devices can display custom maps that you make or download from the internet as
KMZ files.  Here is a web page from Garmin that lists their devices that can use KMZ files to
display maps.  Note that Garmin watches cannot read KMZ files.
https://support.garmin.com/en-US/?faq=xbQGSy1tl95uO4ZmONdQZ8

Here is an outline of the steps to make a custom map for your compatible Garmin device.

A. Use GISsurfer to make a georeferenced JPG.  This can be either a single screenshot or a
series of adjoining screenshots that are stitched together.

B. Make a KMZ file following the instructions in this tutorial 

C. Use the freeware KMZFactory to process the KMZ file into data that certain Garmin
devices can display.  To download KMZFactory follow the link at
http://www.jprenterprises.org/Freebies/.

For instructions on using KMZFactory see the second part of the following article.  You can skip
the first part of the article which shows how to georeference an image.
https://www.instructables.com/Create-Custom-Maps-for-Your-Garmin-GPS

This FAQ describes the restrictions Garmin imposes on custom maps.  The data produced by
KMZFactory is compatible with these restrictions.
https://support.garmin.com/en-GB/?faq=FtEncUXbaE0xE04yZ7gTq5
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12. Make georeferenced PNGs with a transparent background

If you are an ATAK, iTAK or WinTAK user then you likely already know how you can load a
wide variety of basemaps.  If you have georeferenced PNG files with a transparent background
(instead of georeferenced JPGs) then those PNGs can be displayed as an overlay on top of any of
your basemaps.  Here is how to make georeferenced PNG files with a transparent background.

Before taking screenshots, change the GISsurfer basemap to “All white basemap”.

Save each screenshot as a PNG file.

If you took a series of adjoining screenshots then stitch them together and save the composite
image as a PNG file.

The last step is to use image editing software to remove the white background so that the
background becomes transparent.  This is super easy to do with Photoshop but other tools will
also get the job done.  The following instructions were developed using Photoshop CS4 (last
version you could buy and own outright).

A. Start Photoshop and open your PNG file.

B. Select > Color range

C. The “Select” box should show “Sampled colors”.  Set Fuzziness to 20.  Click “OK”.  You
have now selected all the white background.

D. Edit > Cut.  This deletes the white background.  The background should show the
checkerboard which indicates that the background is now transparent.

E. Save this as a PNG file.  This is the file that you will include in a KMZ file along with a
KML file that holds the georeference data.

13. Make a series of screenshots

The real power of using GISsurfer to make georeferenced JPGs and PNGs comes when you
display GIS data that you want to see offline and then make a series of screenshots that you stitch
into a larger composite image.  Stitching the screenshots together is optional but  is easy to do
since the screenshots exactly adjoin with no gaps or overlaps.  You do not need to
‘rubberband’ the final composite image since GISsurfer provides you with the georeference data
for the composite image.

The following recommendations will help you stay organized as you take a series of adjoining
screenshots.
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Tip:   Before actually taking any screenshots, move the map around one screenful at a time (as
described below).  This will help you decide how many screenshots to take.  You might also
decide to adjust the position of the first screenshot.  If you are intending to cover a large area then
a good choice is to work with groups of about 24-25 screenshots.

Start taking screenshots at the upper left of the area to be covered.

Complete the first row of screenshots then shift the screen back on the same row to where you
took the first screenshot.  Then shift the screen down to start the next row of screen shots.
 

PC and Keyboard: After saving a screenshot then use the arrow keys to shift the
GISsurfer screen exactly one screen worth.  Or you can use the letter keys l, r, u, d.

Touchscreen and Mac users: Remember that after each screenshot you must tap the
center of the screen so GISsurfer knows that you took a screenshot and it needs to save
the georeference data.  After you do that then tap in about the middle of any edge to
shift the screen in that direction.  For example, to shift the screen exactly one screen
worth to the right, tap in about the middle of the right hand edge of the screen.

Desktop users can name the screenshot files based on the row and column for how the
screenshots will be stitched together.  If you name files in this manner then you automatically
know where each image file goes as you stitch them together.  For example, if you are going to
take a series of screenshots that are 2 across and 3 down and save them as JPGs, then I
recommend naming your files as follows:

1_1.jpg (upper left screenshot)
1_2.jpg
2_1.jpg
2_2.jpg
3_1.jpg
3_2.jpg (lower right screenshot)

When you are done taking screenshots and are getting out of screenshot mode then you will see
an interface screen with three buttons.  Each button will put the georeferencing data into the
clipboard.  The clipboard data will also have a GISsurfer map link that will replicate the map
that was on your screen when you took the first screenshot.  This map link is extremely useful in
case a screenshot in the series needs to be redone.  You then need to paste the clipboard data
somewhere and save it.  You can save the data from more than one of these buttons.

Tip:  A KML file can hold georeference data for multiple images.  See the section in this PDF
titled “Make a KMZ file” for examples of KML syntax.

Georeference for each screenshot
Use this button if you only took one screenshot or if you took a series of screenshots but
do not intend to stitch them together.  The georeference data will be provided in the same
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order that you took the screenshots.  Instead of stitching the screenshots together, you can
make a KMZ file that includes (1) all your screenshot images and (2) one KML file that
has the georeference data for each screenshot.

Georeference for stitching
This button gives you the georeference data for a composite image you intend to make by
stitching a series of screenshots together.

KML
This button will give you the syntax for a KML file.  Use this button if you intend to
make a KMZ file that includes the KML file plus one or more georeferenced images.

14. Stitch together a series of screenshots

You likely will quickly find it a routine matter to take 20 to 30 screenshots (or more) that exactly
adjoin and stitch them together.  Whatever software you use for stitching you will need to start by
make a new empty file that is the size of the composite image you will make.  For example, if
your screen is 1280 x 1024 and you are going to stitch screenshots together that are 2 wide and 3
tall, then you would make a new empty image that is 2560 x 3072.

Tip:  Here is what to do if you are stitching and discover that one of your screenshot images is
somehow bad.  Open the GISsurfer map link you saved from the clipboard when you were done
taking screenshots.  Go into screenshot mode and use the GISsurfer screen moving controls to
move the screen to the correct position of the bad screenshot.  You can now take a new
screenshot that is in the exact position of the screenshot that was bad.  There is no need to
repeat all of the screenshots.

Below are a few options for stitching your JPGs together.

Photoshop

A. Make a new file of the correct size and with a transparent background.  This will become
your composite image.

B. Open your first JPG or PNG file.   Select > All.   Edit > Copy

C. Go to your new file and do Edit > Paste

D. Activate the Move tool, click-hold on the image you pasted in and drag the image into
position.  If you are following the advice in this PDF then the first position is the upper
left corner of the composite image.

E. Open the next JPG or PNG file and repeat the copy-paste-drag steps until the composite
image is complete.  One nice thing about using Photoshop is that when you are dragging
an image and it gets close to the right location, then it seems to ‘snap’ into place.
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F. If you are making a composite JPG file then when you save the final result apply some
normal compression.  Try compression level 5 which results in a perfectly usable image
that is about 1/3 to 1/4 the size of the uncompressed composite JPG.

Windows 2D Paint program

You will need to open the Paint program twice.  In the first one, make a new empty file that is the
size of the composite image you will make.  To do this click File > Properties and enter the size.

Use the second instance of the Paint program to open your first screenshot image and copy it.

Go back to your first instance of the Paint program and paste in the image you copied.  Then drag
it into position.

I noticed that when dragging the images they do not ‘snap’ into place when they are close to the
right position.  Also I did not find any way using Paint to compress a composite JPG.

Hugin

This is a free open-source stitching program.  I have not used this program but it is well regarded. 
There are versions for both windows and mac.  https://hugin.sourceforge.io
And there is a forum at https://forum.hugin.com.

15. GISsurfer links for USFS, NPS, BLM and NOAA maps

Please keep in mind that the terms of service for GISsurfer specify non-commercial use only.

Below are GISsurfer links that anyone can use to make their own georeferenced JPGs and PNGs. 
You will notice that each link includes a txt file.  You can copy that txt file link, paste it into a
browser and look at the contents.  You will see the syntax that GISsurfer uses to display GIS
data.  Anyone can make similar txt files, put them online and use GISsurfer to display that GIS
data.  

Google Drive will host your text files for free.  For an example showing the syntax to use please
visit https://geojpg.com and click Menu > Help.  Look at the section titled “Host files on Google
Drive for free”.  The example for text files is at the bottom of that section.

When each of the following maps opens some overlay layers are turned on and there are other
overlay layers you can also turn on.  Also, each of these GISsurfer maps has a “Map Tips” link
in the upper left corner with the map legend and other useful information for using the map.  To
get the most benefit out of any map you need to understand a few things about how GISsurfer
works.  Reading the “Map tips” is an excellent way to learn.  Additional documentation for
GISsurfer is at https://gissurfer.com.  The GISsurfer “Help” page has links to video and PDF
tutorials with detailed documentation on various topics.  One of the most important things
to know is that the map will look very different depending on the order with which you turn GIS
overlay layers ‘on’ and ‘off’.
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Of course you can use any GISsurfer map to make georeferenced JPGs and PNGs.  You are not
limited to just the following maps.

National Forests
https://mappingsupport.com/p2/gissurfer.php?center=47.423543,-121.550976&zoom=14&basem
ap=USA_scanned_topo&overlay=Proclaimed_forest,USFS_trail_green,USFS_trail_black_line,U
SFS_road_open_black,USFS_road_open_white,USFS_road_closed,USFS_recreation_site&data
=https://mappingsupport.com/p2/recreation/USFS_recreation.txt

Here is a brief description for some of the possible basemaps you can use.  

A. Open Topo Map.  This basemap covers most of the world and is based on data
from the Open Street Map (OSM) project.  In general, this basemap has the best
trail data however you have to zoom in a bit to see it.

B. USA scanned topo.  This basemap is displayed when the map opens.  These are
scans of the paper USGS 1:24,000 scale topographic maps.  The USGS stopped
updating these paper maps years ago but they show the most detail contour lines.

C. USA topo.  These are current ‘all digital’ topographic maps that the USGS
periodically updates.  The topographic lines are smoothed a bit compared to the
old paper maps.

D. USA forest service topo.  This map uses the same topographic line data that you
see with USA topo.  Road numbers and certain other forest service data are part of
the basemap.  Since this basemap does not include tree cover, the map link turns
on the “2016 tree cover” overlay layer.

National Parks
https://mappingsupport.com/p2/gissurfer-national-park-gis-trail-maps.html

The above web page has a separate GISsurfer map link for each of the 63 national parks.  You
can use any of these map links to make georeferenced JPGs and PNGs.  When you open any of
these maps the trails are highlighted and will be easy to see on any basemap.  Each map has
additional GIS overlay layers you can turn on if they would be useful to you.

Bureau of Land Management (BLM) land
https://mappingsupport.com/p2/gissurfer.php?center=42.682309,-118.706245&zoom=12&basem
ap=USA_basemap&overlay=BLM_land_shaded,BLM_land_outline,State_boundary,BLM_recre
ation_facility,BLM-G_trail_not_assessed,BLM_trail_not_assessed&data=https://mappingsupport
.com/p2/recreation/BLM_recreation.txt

The above BLM GISsurfer link uses the all digital “USA basemap”' which is maintained by the
USGS. To switch to scanned copies of the 1:24,000 scale paper USGS topo maps, change the
basemap to “USA scanned topo”.  Caution - The USGS stopped updating the paper topographic
maps years ago.
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The BLM GIS server has several different layers that might have data for roads or trails. To see a
list of those layers, open the above BLM map and click the basemap button. Mobile users need to
scroll down for the 'Overlay' section. Some of these layers apparently have no data. And
whether or not a road or trail layer has data might vary from one area to the next.

The BLM map can display each road and trail layer twice. Once as a wide colored line and again
as a narrow darker line. This technique of displaying the data twice makes the road and trail
data easy to see on any basemap.

Road layers with a “Y” in the layer name will display a wide yellow line. Trail layers with a “G”
in the layer name will display a wide green line. The companion layer will display the same data
using the styling defined on the GIS server and in a narrow manner on top of the wider colored
line.  Turn on a “Y” or “G” layer first so it is on the bottom and then turn on the companion
layer which is narrower and will be displayed on top of the wider colored layer.

NOAA marine charts - zoom in for more detail.
https://mappingsupport.com/p2/gissurfer.php?center=26.211214,-80.870361&zoom=7&basemap
=NOAA_marine_chart&overlay=AWOIS_obstructions,ENC_wrecks,AWOIS_wrecks&data=htt
ps://mappingsupport.com/p2/recreation/USA_NOAA_nautical.txt

FAA flight charts 
The are four FAA basemaps.  Each one displays at different zoom levels.  For more info on that,
open the “Map tips” and read the Introduction.
https://mappingsupport.com/p2/gissurfer.php?center=39.200866,-76.663971&zoom=10&basema
p=FAA_VFR_Sectional&data=https://mappingsupport.com/p2/recreation/USA_FAA_charts.txt

16. GISsurfer example displaying GPX data

Before taking screenshots you can tell GISsurfer to display both various layers of GIS data plus
data from one or more GPX files.  Currently this will only display GPX track data.  The GPX file
has to be online somewhere and reachable with a simple link that does not require any kind of
login.

GPX files can be hosted on Google Drive for free.  For instructions see this PDF file: 
https://mappingsupport.com/p2/help/GISsurfer-data-parameter.pdf
Read the section “Free hosting for TXT and GPX files”.

To display a GPX file with GISsurfer, use the data parameter.  Below is an example where the
data parameter points to (1) a txt file that specifies GIS layers and also (2) a GPX file with track
data (red line on the map).  Note the two vertical lines || which separate pieces of information for
the data parameter.

https://mappingsupport.com/p2/gissurfer.php?center=47.419697,-121.565351&zoom=14&basem
ap=USA_scanned_topo&overlay=Proclaimed_forest,USFS_trail_green,USFS_trail_black_line,U
SFS_road_open_black,USFS_road_open_white,Landform_names,USFS_recreation_site&data=h
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ttps://mappingsupport.com/p2/recreation/USFS_recreation.txt||https://mappingsupport.com/gpx/
Bandera.gpx

17. Existing georeferenced JPGs anyone can use

I have used GISsurfer’s screenshot mode to produce georeferenced JPGs for certain areas in
Washington State and California.  Anyone is welcome to use these georeferenced JPG maps. 
Some maps are made from stitching together 25 or more screenshots.  These large JPG maps
cover all of the Washington State Cascades within reasonable driving distance of the greater
Seattle area for a day trip.  There also are a number of small JPG maps that typically are a single
screenshot and cover the area of popular day hikes.

There are two sets of these georeferenced JPG maps.  Both sets cover the same areas.  One set
uses the Open Topo Map basemap.  These basemaps generally have the best trail data.  The
other set uses the historical USGS topo maps.  These maps have the best contour data for off-
trail travel.

All of these georeferenced JPG maps are hosted on Google Drive.   Instead of long list of links
to individual JPGs, I have created several text files that also are hosted on Google Drive.  Each
text file contains one of more specifications for georeferenced JPGs.  You can use those text file
specifications with both GISsurfer and with GeoJPG.  To find those text file specifications open
https://geojpg.com and click Menu > JPG Maps Anyone Can Use.
 
To see the content of any text file copy the entire https google link and paste it into a browser. 
Be sure to include the ‘id’ value since that is the unique identifier for the file on Google Drive.

Here is an GISsurfer link that reads one of those text files and displays the two JPG files that are
specified in that text file.  These JPG maps display the Open Topo Map and a wide semi-
transparent line of trail data from federal ArcGIS server.

https://mappingsupport.com/p2/gissurfer.php?data=WA_small_Teanaway_open_topo_txt^https:/
/drive.google.com/uc?export=download&id=11o0_ouPwI54qKCVPzH_xf9y1UShJXtvr

18. Existing georeferenced PNGs anyone can use

This section includes links to example KMZ files that cover all of Ventura County California. 
One set of KMZ files include georeferenced images that highlight certain GIS data including
trails and have a transparent background.  The other set of KMZ files highlights the same GIS
data and has a basemap of the historical USGS topographic maps.

The following example shows the benefit of (1) using dynamic layers to restyle ArcGIS data
and (2) using PNG files with a transparent background.  For this example, six PNG files were
made that exactly adjoin.  Each of those PNG files consists of multiple screenshots that exactly
adjoin and were stitched together.  These PNG files cover all of Ventura County California.
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The GIS layers used for the map show road and trail data that is hosted by Ventura County and
the U.S. Forest Service.  Trails are green/black.  Roads the USFS has closed are red dashes.  The
Ventura County boundary is orange.

Below is the GISsurfer map link that was used to take the Ventura County screenshots.  Since the
goal is to make PNG files with a transparent background, the basemap is set to “All white
basemap”.  If you want to see the dynamic layers syntax that was used to restyle the data, then
download and open the txt file that you see at the end of the GISsurfer link.

https://mappingsupport.com/p2/gissurfer.php?center=34.875123,-119.403963&zoom=14&basem
ap=All_white_basemap&overlay=Ventura_County_boundary,Proclaimed_forest,Ventura_trail_g
reen,Ventura_trail_black,USFS_trail_green,USFS_trail_black,USFS_road_open_black,USFS_ro
ad_open_white,Ventura_road_black,USFS_road_closed,USFS_recreation_site&data=https://map
pingsupport.com/p2/kmz_demo/ventura_county_trails_1.txt

Here is a KML file with the georeference data for the six PNG images.  You can open this file in
any text editor.
https://mappingsupport.com/p2/kmz_demo/ventura_county_all_transparent.kml

And below is a link for a large KMZ file that will display the six PNG files.  If you open this
KMZ as an overlay with ATAK, iTAK or WinTAK then you can display this data on top of
any basemap.  You can also open this KMZ with Google Earth, QGIS or any other software the
supports KMZ files that contain georeferenced images.
https://mappingsupport.com/p2/kmz_demo/ventura_county_all.kmz  21MB

If for any reason the 20MB KMZ file does not work for you, then here are three smaller KMZ
files.  Each file will display two PNG files with transparent backgrounds.

Ventura County north
https://mappingsupport.com/p2/kmz_demo/ventura_north_transparent.kmz  4MB

Ventura County middle
https://mappingsupport.com/p2/kmz_demo/ventura_middle_transparent.kmz  6MB

Ventura County south
https://mappingsupport.com/p2/kmz_demo/ventura_south_transparent.kmz  11MB
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The following KMZ files have the images using the historical USGS topographic map as the
basemap.

All of Ventura County
https://mappingsupport.com/p2/kmz_demo/ventura_county_all_topo.kmz  37MB

Ventura County north
https://mappingsupport.com/p2/kmz_demo/ventura_north_topo.kmz  10MB

Ventura County middle
https://mappingsupport.com/p2/kmz_demo/ventura_middle_topo.kmz  16MB

Ventura County south
https://mappingsupport.com/p2/kmz_demo/ventura_south_topo.kmz  11MB

19. Several ways to search ArcGIS servers for specific data

Let’s assume that you are looking for GIS layers with trail data.  First, to look for state level data
a good place to start is with this website which had links to data portals for all states.
http://opensourcegisdata.com/state/index.html

If you use a data portal and find a ‘hit’ to some ArcGIS data that you want to see on a map, then
you might have to poke around a bit to find the actual address to MapServer, FeatureServer or
ImageServer data layer that GISsurfer can display.  Look for a link or button that says “View data
source”.

Note that portals typically only index a relatively small number of layers on the state’s GIS
servers.

Second, you could look through the table of contents of an ArcGIS server.  This is simply a
series of web pages.  Below is a link to a curated list with addresses for 3,000+ ArcGIS servers at
all levels of government from federal to local.  An updated list is usually posted each Wednesday
with any bad links either fixed or flagged.  Each ArcGIS server link will open the top of the table
of contents for that server.
https://mappingsupport.com/p/surf_gis/list-federal-state-county-city-GIS-servers.pdf

Here is a video to help you learn how to use an ArcGIS server’s table of contents.
https://youtu.be/cnZfLOQZfX8

Third, you can also use google to search a specific ArcGIS server for data by making a search
like so:

site:___________  keyword     Tip: Do not leave a space after “site:”

For example, to search for trail data in Ventura County California you could start by looking at
the curated list of ArcGIS servers.  Sure enough, there is an ArcGIS server listed for Ventura
County.  So make your google search like this:
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site:https://maps.ventura.org/arcgis/rest/services  trail
Success!  The above search turns up a layer of GIS data at:
http://maps.ventura.org/arcgis/rest/services/SDs/HikingTrail/MapServer/0

If you spend a few minutes with the documentation on the GISsurfer website then you will learn
how to make a GISsurfer map link like you see below to display this trail data.

https://mappingsupport.com/p2/gissurfer.php?center=34.483320,-119.036865&zoom=10&basem
ap=USA_basemap&overlay=Hiking_Trails&data=overlay^name=Hiking_Trails^url=http://maps
.ventura.org/arcgis/rest/services/SDs/HikingTrail/MapServer^layers=0

If you open the above map then you will see that the trail data is rather hard to see.  It is even
harder to see if you switch the basemap to “USA scanned topo”.  This is the styling that is
defined on the ArcGIS server.  You can use GISsurfer and “dynamic layers” to restyle this trail
data so it is easier to see on the map.  For more information please see this PDF:
https://mappingsupport.com/p2/help/GISsurfer-advanced-arcgis-tips.pdf

20. Search worldwide for GIS data

Try https://www.geoseer.net/.  This site is a “spatial data search engine”.  If you find data host on
a WMS server or XYZ tile server then You can display that data with GISsurfer.  Here is a video
that shows you how to display that type of data using GISsurfer.  https://youtu.be/qz0EHExTKSk
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